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Notice 

1. All information included in this document is current as of the date this document is issued. Such information, however, is 
subject to change without any prior notice. Before purchasing or using any Renesas Electronics products listed herein, please 
confirm the latest product information with a Renesas Electronics sales office. Also, please pay regular and careful attention to 
additional and different information to be disclosed by Renesas Electronics such as that disclosed through our website. 

2. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights 
of third parties by or arising from the use of Renesas Electronics products or technical information described in this document.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights
of Renesas Electronics or others. 

3. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part.
4. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of 

semiconductor products and application examples.  You are fully responsible for the incorporation of these circuits, software, 
and information in the design of your equipment.  Renesas Electronics assumes no responsibility for any losses incurred by 
you or third parties arising from the use of these circuits, software, or information. 

5. When exporting the products or technology described in this document, you should comply with the applicable export control 
laws and regulations and follow the procedures required by such laws and regulations.  You should not use Renesas 
Electronics products or the technology described in this document for any purpose relating to military applications or use by 
the military, including but not limited to the development of weapons of mass destruction.  Renesas Electronics products and 
technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited 
under any applicable domestic or foreign laws or regulations. 

6. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics
does not warrant that such information is error free.  Renesas Electronics assumes no liability whatsoever for any damages 
incurred by you resulting from errors in or omissions from the information included herein. 

7. Renesas Electronics products are classified according to the following three quality grades:  “Standard”, “High Quality”, and
“Specific”.  The recommended applications for each Renesas Electronics product depends on the product’s quality grade, as 
indicated below.  You must check the quality grade of each Renesas Electronics product before using it in a particular 
application.  You may not use any Renesas Electronics product for any application categorized as “Specific” without the prior 
written consent of Renesas Electronics.  Further, you may not use any Renesas Electronics product for any application for 
which it is not intended without the prior written consent of Renesas Electronics.  Renesas Electronics shall not be in any way
liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for an
application categorized as “Specific” or for which the product is not intended where you have failed to obtain the prior written
consent of Renesas Electronics.  The quality grade of each Renesas Electronics product is “Standard” unless otherwise 
expressly specified in a Renesas Electronics data sheets or data books, etc. 

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual 
equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots. 

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
crime systems; safety equipment; and medical equipment not specifically designed for life support. 

“Specific”:  Aircraft; aerospace equipment; submersible repeaters; nuclear reactor control systems; medical equipment or 
systems for life support (e.g. artificial life support devices or systems), surgical implantations, or healthcare 
intervention (e.g. excision, etc.), and any other applications or purposes that pose a direct threat to human life. 

8. You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics,
especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation 
characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or
damages arising out of the use of Renesas Electronics products beyond such specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have 
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further, 
Renesas Electronics products are not subject to radiation resistance design.  Please be sure to implement safety measures to 
guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a 
Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire 
control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures.  Because 
the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or system 
manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental 
compatibility of each Renesas Electronics product.  Please use Renesas Electronics products in compliance with all applicable 
laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS 
Directive.  Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with 
applicable laws and regulations. 

11. This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written consent of Renesas
Electronics. 

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this 
document or Renesas Electronics products, or if you have any other inquiries. 

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its majority-
owned subsidiaries. 

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics. 
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Introduction 
This document gives the outline of the Peripheral Driver Generator (PDG) V.2.xx features and basic usage. 
For how to set up peripheral modules for each MCU, specifications of functions output by the PDG, and other 
points for caution, refer to the reference manual for the MCU in use.  
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1. Overview 

1.1 Peripheral Driver Generator 

The Peripheral Driver Generator (hereafter referred to as the PDG) outputs functions for controlling the 
MCU’s peripheral modules (e.g. serial communications interface, timers, I/O ports) when the corresponding 
settings have been input through the GUI. Calling these functions from a user program makes the peripheral 
modules operate in the way you have defined. 
When the source files output by the PDG is registered with the integrated development environment (IDE) 
High-performance Embedded Workshop: hereafter referred to as the HEW or CubeSuite+ and built with a user 
program, the control of the peripheral modules will also be implemented in the user program. 
 

1.2 System Configuration and Procedures 

Figure 1.1 shows the system configuration of the PDG and associated tools and the procedures. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Software 

PDG 

(2) 

Output source files RPDL 

IDE 

User 
program 

(4) 

(6) 

(7) 

(1) The PDG settings are saved in project files. When you use 
the PDG for the first time, you need to create a new project 
or open the sample project that has been provided. 

(2) Set up peripheral modules through the GUI of the PDG. The 
settings will vary with the MCU.  

(3) The PDG outputs source files based on the settings made in 
step (2). 

(4) Add the output source files and Renesas Peripheral Driver 
Library (RPDL) to the IDE. The functions included in the 
source files only work in combination with the RPDL. For 
the relationship between the RPDL and the functions output 
by the PDG, refer to 1.3 Functions Output by the PDG and 
Renesas Peripheral Driver Library (RPDL). 

(5) The driver can be used by calling the functions output by 
the PDG from user program. Create a program that calls the 
functions output by the PDG.  

(6) Build the program (e.g. created by using the IDE), 
PDG-output source files, and RPDL to create a load 
module. 

(7) The source files and RPDL will be the driver software for 
peripheral modules in the user system. 

(3) 

User system 
Figure 1.1   System Configuration and Procedures 
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1.3 Functions Output by the PDG and Renesas Peripheral Driver Library (RPDL) 

The functions output by the PDG use the API functions of the RPDL included in the PDG package. The RPDL 
is a driver-API library that that is provided for each of the MCUs. The API functions of the RPDL control the 
peripheral modules that correspond to the parameters being called.  
Each of the functions output by the PDG internally calls the corresponding API function(s) of the RPDL so 
that the peripheral module will operate in the way that has been defined. The parameters to call the API 
functions are automatically selected from the settings made though the GUI. You can control peripheral 
modules by calling simple functions output by the PDG through a user program. Always use the RPDL 
included in the PDG package. Correct operation of the PDG is not guaranteed if the RPDL alone is upgraded. 
Figure 1.2 shows the relationship between an API function of the RPDL, function output by the PDG, and user 
program in the case of setting up the 8-bit timer (TMR) in the RX610 group as an example. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

It is also possible to directly call API functions from a user program. For specifications of the API functions of 
the RPDL, refer to the RPDL user’s manual specific to the MCU.  

Function output by the PDG 

API function of the RPDLfor the RX610 

PDG 

Output a function

User program 

Call a function output by the PDG

Figure 1.2   Relationship between an API Function of the RPDL, Function Output by the PDG, and User Program

Set up the  

peripheral module 

Call the corresponding API function of the RPDL

The parameter to call the API 
function reflects GUI settings. 

  R_PG_Timer_Start_TMR_U1( ); 

bool R_PG_Timer_Start_TMR_U1( void ) { 
R_TMR_CreateUnit( 
 

    1,  
PDL_TMR_CLK_PCLK_DIV_64 | PDL_TMR_CLEAR_DISABLE | 
PDL_TMR_ADC_TRIG_DISABLE |  
PDL_TMR_DTC_TRIGGER_DISABLE, 
PDL_TMR_OUTPUT_IGNORE_CM_A | 
PDL_TMR_OUTPUT_IGNORE_CM_B, 
0, 
0x6000, 
0xB000, 
TmrOf2IntFunc, 
TmrCma2IntFunc, 
TmrCmb2IntFunc, 
7 ); 
 

} 

bool R_TMR_CreateUnit( 
  uint8_t data1, uint32_t data2, uint8_t data3, uint16_t data4, 

uint16_t data5, uint16_t data6, void * func1, void * func2, 
void * func3, uint8_t data7) 

{ 
 
 
} 

Processing for control of the peripheral module 
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1.4 Compatibility with PDG V.1.0x  

V.1.0x and V.2.xx of the PDG support different types of MCUs. Thus V.2.xx cannot load project files 
created by V.1.0x. It is also not possible to convert project files created by V.1.0x to suit the MCUs 
supported by V.2.xx. 
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2. Preparations 

2.1 Preparing the IDE 

2.1.1 When the HEW is in Use 

If you wish to use the source files generated by the PDG to create programs or build files in the HEW, install 
the HEW and set it up so that files for the MCU in use can be built. You need to upgrade the HEW to 
V.4.05.01 if the version of the HEW you are currently using is V.4.05.00 or earlier. 
 

2.1.2 When the CubeSuite+ is in Use 

If you wish to use the source files generated by the PDG to create programs or build files in the CubeSuite+, 
install the CubeSuite+ and set it up so that files for the MCU in use can be built. You need to upgrade the 
CubeSuite+ to V1.02.01 if the version of the CubeSuite+ you are currently using is V1.02.00 or earlier. 
 

2.2 Installing the PDG 

Start up the installer and follow the instructions given on the screen. You should have an administrator right to 
install the PDG. 
 
If you are installing the PDG in an environment where no HEW has been installed, the message shown in 
figure 2.1 will be displayed. Click on [Yes] to continue installation.  
 
 
 
 
 
 
 
 
 
 
 

Figure 2.1   Message in Cases Where No HEW has been Installed 
 

Even if PDG V2.0 is installed in an environment where V.1.0x has been installed, V.1.0x will not be 
overwritten. Thus you can also use V.1.0x after V2.0 is installed.  

 



Peripheral Driver Generator User’s Manual Preparations 

R20UT0149EJ0102  Rev.1.02  Page 9 of 27 
Jun 1, 2012  

 

2.3 HewTargetServer Setting in the HEW (When the HEW is in Use) 

The PDG is capable of adding source files to the HEW and automatically making settings on the HEW 
required to build the files. To utilize this facility to add source files to the HEW, you need to set up the 
HewTargetServer in the HEW. 
Follow the procedures below to check the current HewTargetServer setting and modify it if necessary. If 
multiple HEWs have been installed, select one that you wish to add source files to. For how to add sources 
from the PDG to the HEW, refer to 3.7 Adding Source Files to the HEW. 

(1) Check the HewTargetServer setting 

Take the following steps to check the HewTargetServer setting. 
 

1. Select [Administration…] from the [Tool] menu in the HEW. 

2. Click on [Extension Components] in the [Tools Administration] dialog box and see if the 

HewTargetServer is included in the list. Also check the version number of the HewTargetServer. 
 

(2) Set up the HewTargetServer  

When the HewTargetServer is not included in the list or the version number is earlier than 1.07.00, take the 
following steps. 

 
1. Select [Administration…] from the [Tool] menu in the HEW with no workspaces open. 

2. If the version number of the HewTargetServer listed under [Extension Components] in the [Tools 

Administration] dialog box is earlier than 1.07.00, select the HewTargetServer and click on the 

[Unregister] button. 

3. Click on the [Search disk…] button in the [Tools Administration] dialog box. The [Search Disk for 

Components] dialog box opens. 

4. Enter the name of the directory in which the HEW has been installed and click on the [Start] button. The 

PDG starts searching for components. 

5. The results of the search are shown in the [Located Components] list. Select a HewTarget Server whose 

version number is 1.07.00 or later, and click on the [Register] button. 

6. Click on the [Close] button to close the [Search Disk for Components] dialog box. Then click on the 

[OK] button in the [Tools Administration] dialog box. 
 

(3) Add the HewTargetServer to the registry 

If you have used Install Manager Version 1.02 or earlier to install multiple HEWs and switched the active 
HEW to another, add the HewTargetServer to the registry again as follows. 

 
1. Execute REGISTERSERVER.bat stored in the HEW installation directory. When you are using the 

Windows Vista operating system, execute the file via the command prompt you have opened as an 

administrator. 
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3. Operating the PDG 

3.1 Procedure 

Figure 3.1 shows the procedure from setting up peripheral modules in the PDG to adding source files to the 
IDE to build them. For details on how to operate the IDE, refer to the related documents. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Start up the PDG 

Create or load a PDG project 

Set up periheral modules 

Generate source files 

Add source files to the IDE 

Start up the IDE 

Create or load a IDE project 

Create a program 

Build 

Run and debug the program 

Refer to section 3.2, Starting up. 

Refer to section 3.3, Creating or Loading 
a Project. 

Refer to section 35, Setting up Peripheral 
Modules. 

Refer to section 3.6, Generating Source 
Files. 

Refer to section 3.7, Adding Source Files 
to the IDE. 

Operations in the PDG Operations in the IDE 

Figure 3.1   Operating Procedures in the PDG and IDE 
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3.2 Starting up 

Select [Peripheral Driver Generator 2] from the Windows [Start] menu. 

3.3 Creating or Loading a Project 

MCU settings created with the PDG must be saved in a project. Create a new project or open an existing 
project. 

(1) Create a new project 
 

1. Select [New Project] from the [File] menu in the PDG. 
2. Make necessary settings in the [New Project] dialog box and click on [OK]. 

Items shown in the [New Project] dialog box are listed below. 
The settings made in the [New Project] dialog box cannot be modified after a project has been 
created.  

Table 3.1   Items in the [New Project] Dialog Box 
Item Description 

Project Name Enter the name of a new project. 

Directory Specify the directory in which you wish to create a project. 

CPU Type Select the series, group, and type names of the MCU that you wish to use. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(2) Load an existing project 
 

1. Select [Open…] from the [File] menu in the PDG. 
2. Select a project file in the [Open File] dialog box. The extension for project files is .pg2. Clicking 

on the [OK] button opens the selected project. 
 

Figure 3.2   [New Project] Dialog Box 
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3.4 Window 

The PDG’s main window appears when a project is opened. The configuration of the main window is shown 
below.  
 

(a) Main menu 
(b) Toolbar 
(c) Peripheral-module 
selection tabs 
(d) Resource pane 
(e) Detailed-setting pane 
(f) Source-file pane 

 
 
 
 
 
 
 

Figure 3.3   Main Window 

(a) 

(b) 

(c) 

(d)

(f)

(e)
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3.4.1 Main Menu 

 
 
Table 3.2 lists the menu items. 

Table 3.2   Menu Items 
Menu Description 

New Project… Opens the [New Project] dialog box that allows you to create a new project. 

Open… Opens the [Open File] dialog box that allows you to open an existing project. 

Close Closes the current project. When the project has been modified, the 

confirmation dialog box appears asking whether you wish to save the project. 

Save Saves the current project. 

Save As… Opens the [Save As] dialog box that allows you to save the current project with 

a new name. 

1 to 5 project names Shows the names of the five projects most recently opened. 

File 

Exit Quits the PDG 

Toolbar Switches showing and hiding of the toolbar. 

Status bar Switches showing and hiding of the status bar. 

Generated source file 

information window 

Switches showing and hiding of the source-file pane. 

View 

Character size of the 

generated source 

information window 

The size (large, medium, or small) of characters in the source-file pane is 

selectable from the sub-menu. 

Options... Opens the [Options] dialog for setting up the editor used when opening the 

source file generated in the project. 

Generate source files Generates source files. 

Add files to a HEW 

project 

Adds the generated source files to a HEW project. 

Add files to a 

CubeSuite+ project 

Adds the generated source files to a CubeSuite+ project. 

Tool 

Generate pin lists Outputs pin lists to CSV files. 

About PDG2... Shows the version information. Help 

Device Information... Shows the device information. 
 

Figure 3.4   Main Menu 
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3.4.2 Toolbar 

 
 

 
Some items in the main menu are also available as toolbar buttons. Table 3.3 lists these items. 

Table 3.3   Toolbar Buttons and Corresponding Menu Items 
Toolbar Button Menu Item 

 [File] → [New] 

 [File] → [Open] 

 [File] → [Save] 

 [Tool] → [Generate source files] 

 [Tool] → [Add files to a HEW project] 

 [Tool] → [Add files to a CubeSuite+ project] 

 [Tool] → [Generate pin lists] 

 [Help] → [About PDG2...] 
 

3.4.3 Peripheral-Module Selection Tabs 

 
 
 
 
Use these tabs to select peripheral modules that you wish to set up. When you click on a tab, the resource, 
detailed-setting, and source-file panes all show the information specific to the selected peripheral module. 
Along with the tabs specific to peripheral modules, the [SYSTEM] tab is provided for settings associated with 
the entire system of the MCU (e.g. clock sources and pin functions). 
When the PDG is reporting an error or warning in setting of a peripheral module, the icon shown in figure 3.7 
appears on the corresponding tabbed page. For details on errors or warnings, refer to 3.5.2 Errors and 
Warnings. 
 
 
 
 
The tabs vary with the MCU. For details on the tabs, refer to the reference manual for the MCU in use. 

 

Figure 3.5   Toolbar 

Figure 3.6   Peripheral-Module Selection Tabs (RX610)

Figure 3.7   Tabbed Page in Case of an Error or Warning  
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3.4.4 Resource Pane 

 
 
 
 
 
 
 
 
 
 
This pane shows the resources (e.g. timer channels and ports) of the selected peripheral module. Clicking on a 
resource switches the display in the detailed-setting pane: the information will now be specific to the selected 
resource. For some peripheral modules, other categories (e.g. pin functions) are displayed as well as the MCU 
resources. 
When the PDG is reporting an error or warning in setting of a peripheral module, the icon shown in figure 3.9 
is attached to the resource having the problem. For details on errors or warnings, refer to 3.5.2 Errors and 
Warnings. 
The contents of this pane vary with the MCU. For details on the resources, refer to the reference manual for the 
MCU in use. 

Figure 3.8   Resource Pane (RX610/TMR) Figure 3.9   Icon Indicating an Error or Warning 
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3.4.5 Detailed-Setting Pane 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This pane allows you to set up details on the selected peripheral module or entire system. When opened, the 
pane shows the current settings on the hardware resources or other categories selected in the resource pane. 
When the PDG is reporting an error or warning in setting of a peripheral module, the icon shown in figure 3.11 
is attached to the item having the problem. For details on errors or warnings, refer to 3.5.2 Errors and 
Warnings. 
 
 
 
 
 

Figure 3.10   Detailed-Setting Pane (RX610/Clock) 

Figure 3.11   Icon Indicating an Error or Warning 

(a) Error (b) Warning 
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3.4.6 Source-File Pane 

 
 
 
 
 
 
 
 
This pane shows the information on the source files generated by the PDG. Nothing is displayed in the pane if 
you have created a project but have not executed [Generate source files] yet. When [Generate source files] is 
executed, the PDG generates source files based on the current settings on the selected peripheral module and 
the contents of this pane are updated. 
Source files are managed in units of peripheral modules. Clicking on button for a peripheral module opens a 
list of souce files for that module. Other related files are shown on [Others].  
Table 3.4 lists the columns in the source-file pane. 

Table 3.4   Columns in the Source-File Pane 
Column Description 

Source file name Name of the source file (full path) 

Generated function Name Definition of the output function 

Explanation of functions Action triggered by the function 

 
For how to generate source files, refer to 3.6 Generating Source Files. 
For specifications of the output functions, refer to the reference manual for the MCU in use.  

Figure 3.12   Source-File Pane (RX610) 
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3.5 Setting up Peripheral Modules 

3.5.1 Basic Operation 

Take the following steps to set up peripheral modules. 
 

1. Select the tab for a peripheral module that you wish to set up. The resource pane is updated to show 

information specific to the selected module (figure 3.13-1).  

2. Select a resource in the resource pane. The detailed-setting pane is updated to show information specific 

to the selected resource (figure 3.13-2). 

3. Make settings in the detailed-setting pane (figure 3.13-3). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 

2 
3 

Figure 3.13   Setting up a Peripheral Module 

Resource pane 

Peripheral-module selection tabs 

Detailed-setting pane 
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3.5.2 Errors and Warnings 

(1) Error and Warning Icons 

When there is a problem with setting of a peripheral module, an error or warning icon appears on the 
corresponding section in the detailed-setting pane, resource pane, and peripheral-module selection tabbed 
page. 
 
 
 
 
 
To show the additional information, the information icon appears. 
 
 
 

(2) Detailed Information 

Placing the mouse pointer on each icon shows the tooltip information on the error or warning. 
 
 
 
 
 
 

(3) Definitions 

Table 3.5 shows the definitions of error and warning and whether the PDG will still generate source files. 

Table 3.5   Definitions of Error and Warning 
Type Definition Source Generation 

Error Not allowed by hardware specification or may cause a problem 

with behavior of the PDG 

Available 

Warning Allowed by hardware specification but may cause unintended 

behavior of the PDG 

Not available 

 
For how to generate source files, refer to 3.6 Generating Source Files. 
 

Figure 3.14   Error and Warning Icons 

(a) Error (Example) (b) Warning (Example) 

Figure 3.16   Tooltip Information on an Error and Warning 

Figure 3.15   Information Icon 
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3.6 Generating Source Files 

3.6.1 Starting Generation of Source Files 

To start generation of source files, select [Generate source files] from the [Tool] menu or click on the 
[Generate source files] toolbar button (  ). 

3.6.2 Location of Output Source Files 

Source files are generated in the PDG’s project directory and its subdirectories. 

3.6.3 Changing Periperal-Module Settings and Generating Source Files Again 

Executing [Generate source files] generates all source files associated with the periperhal modules for which 
settings have been made. If any of the source files has the same name as an existing source file that has already 
been generated in the current project, the older file is overwritten (i.e. the older file is replaced with new one 
regardless of whether peripheral-module settings have been changed or not since the previous generation). 
When [Generate source files] is executed after the settings for a peripheral module at the time of previous 
generation have been cleared, the existing files associated with the cleared settings are deleted. Note, however, 
that these files are not automatically removed from the IDE. You need to manually remove obsolete files from 
IDE projects. 

3.6.4 When an Error or Warning is Encountered 

When there are one or more errors in peripheral-module settings, the message shown in figure 3.17 appears 
indicating that [Generate source files] is not executable. Check the location of the error and modify the setting.  

 

 
 
 
 
 

3.6.5 Checking the Source Files 

As soon as [Generate source files] is executed, the source-file pane displays the source files and functions.  
For contents of the source-file pane and how to handle them, refer to 3.4.6 Source-File Pane. 
 

Figure 3.17   Message When an Error is Encountered 
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3.7 Adding Source Files to the IDE 

3.7.1 Processes of Adding Source Files to the HEW 

(1) Processes of adding source files 

Executing [Add files to a HEW project] not only adds source files to the HEW but also makes further setting 
for building the source files and RPDL. The following processes are included. 

 

(a) Add source files to the HEW 
C source files generated by the PDG are added to the HEW. These files are displayed within the 
AddFromPDG folder in the HEW’s workspace window. 
‘Adding source files” does not mean copying the C source files and header files generated by the PDG into 
the HEW project file directory. The files are just registered with the HEW. 

 

(b) Make setting for linkage of library files 
The functions output by the PDG use the API functions of the RPDL. So linkage setting must be made to 
build source files. The RPDL’s library files are not copied into the HEW project file directory: these files in 
the PDG installation directory are just registered with the HEW.  
During this process, the library link priority setup dialog box appears so that you can specify the linkage 
order of the library files, including those you have already added. For how to make settings in the library 
link priority setup dialog box dialog box, refer to 3.7.3 Specifying the Linkage Order of Library Files. 
For the relationship between the RPDL and the functions output by the PDG, refer to 1.3 Functions Output 
by the PDG and Renesas Peripheral Driver Library (RPDL). 

 

(c) Assigning an include-file directory 
The PDG assigns the folder containing each of the header files, which are necessary for the use of functions 
output by the PDG, as an include-file directory.  

 

(d) Exclude conflicting files from building 
The application project created by the HEW includes a startup program. Part of the program (mostly the 
processes related to interrupt handlers) may conflict with some source files to be added to the HEW so the 
PDG excludes such files from building.  
For details on source files excluded from building, refer to the reference manual for the MCU in use.  

 

(2) User Operation 

To add source files to the HEW, select [Generate source files] from the [Tool] menu in the PDG or click on the 
[Generate source files] toolbar button (  ). The confirmation message shown in figure3.18 appears. Click 
on [OK] to start adding of source files to the HEW. 
 
 
 
 
 
 

 Figure 3.18   Confirmation Message on Adding Source 
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(3) Specifying the Linkage Order of Library Files 

When all of the source files have been added to the HEW, the library link priority setup dialog box appears so 
that the linkage order of the RPDL library and other library files can be specified.  
Select desired library files and click on the [Up] or [Down] button to change the linkage order of those files. 
Clicking on [OK] finalizes the linkage order and starts to make the setting. 

 

(4) Completion of Adding Source Files 

When all processes are completed, a dialog box shown in figure 3.19 appears. 
 

(5) Points for Caution 

Take the following points into account when adding source files to the HEW. 
 

(a) HewTargetServer setting 
To add source files to the HEW, you need to set up the HewTargetServer in the HEW in advance. If you 
execute [Add source files to a HEW project] with no HewTargetServer set up in the HEW, source files are 
not added to the HEW (but no error messages are displayed). For details on setting up the HewTargetServer, 
refer to 2.3 HewTargetServer Setting in the HEW. 

 

(b) Location of the added source files 
Source files are added to the current project in the HEW that is active when [Generate source files] is 
executed. Do not execute [Generate source files] while two or more HEWs are open. 

 

(c) State of the HEW at the time of adding source files 
The PDG cannot add source files if the HEW has not been started up or no workspaces are open. Before 
executing [Generate source files], check that the HEW has been activated and a workspace is open. 
If building or some related setting is attempted or already in progress in the HEW when [Generate source 
files] is executed, the message shown in figure 3.20 appears to stop the process of adding source files. 
Execute [Generate source files] after building or other setting has been completed. 
 
 
 
 
 
 

 

Figure 3.19 Message on completion Figure 3.20 Message on HEW busy 
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(6) Creating Programs Including the PDG-Output Functions 

You can control peripheral modules by simply calling PDG-output functions through a user program. For 
details on the functions and usage, refer to the reference manual for the MCU in use. 
 

3.7.2 Processes of Adding Source Files to the CubeSuite+ 

(1) Processes of adding source files 

Executing [Add files to a CubeSuite+ project] not only adds source files to the CubeSuite+ but also makes 
further setting for building the source files and RPDL. The following processes are included. 

 

(a) Add source files to the CubeSuite+ 
C source files generated by the PDG are added to the CubeSuite+. These files are displayed within the 
AddFromPDG folder in the CubeSuite+’s workspace window. 
‘Adding source files” does not mean copying the C source files and header files generated by the PDG into 
the CubeSuite+ project file directory. The files are just registered with the CubeSuite+. 

 

(b) Make setting for linkage of library files 
The functions output by the PDG use the API functions of the RPDL. So linkage setting must be made to 
build source files. The RPDL’s library files are not copied into the CubeSuite+ project file directory: these 
files in the PDG installation directory are just registered with the CubeSuite+.  
During this process, the library link priority setup dialog box appears so that you can specify the linkage 
order of the library files, including those you have already added. For how to make settings in the library 
link priority setup dialog box dialog box, refer to 3.7.3 Specifying the Linkage Order of Library Files. 
For the relationship between the RPDL and the functions output by the PDG, refer to 1.3 Functions Output 
by the PDG and Renesas Peripheral Driver Library (RPDL). 

 

(c) Delete conflicting files from project 
The application project created by the CubeSuite+ includes a startup program. Part of the program (mostly 
the processes related to interrupt handlers) may conflict with some source files to be added to the 
CubeSuite+ so the PDG deletes such files from project. 
For details on source files deleted from project, refer to the reference manual for the MCU in use. 

 

(2) User Operation 

To add source files to the CubeSuite+, select [Generate source files] from the [Tool] menu in the PDG or click 
on the [Generate source files] toolbar button (    ). 

 

(3) Specifying the Linkage Order of Library Files 

When all of the source files have been added to the HEW, the library link priority setup dialog box appears so 
that the linkage order of the RPDL library and other library files can be specified.  
Select desired library files and click on the [Up] or [Down] button to change the linkage order of those files. 
Clicking on [OK] finalizes the linkage order and starts to make the setting. 
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(4) Completion of Adding Source Files 

When all processes are completed, a dialog box shown in figure 3.21 appears. 
 

(5) Points for Caution 

Take the following points into account when adding source files to the CubeSuite+. 
 

(a) Location of the added source files 
Source files are added to the current project in the CubeSuite+ that is active when [Generate source files] is 
executed. Do not execute [Generate source files] while two or more CubeSuite+s are open. 

 

(b) State of the CubeSuite+ at the time of adding source files 
The PDG cannot add source files if the CubeSuite+ has not been started up or no projects are open. Before 
executing [Generate source files], check that the CubeSuite+ has been activated and a workspace is open. 
If building or some related setting is attempted or already in progress in the CubeSuite+ when [Generate 
source files] is executed, the message shown in figure 3.22 appears to stop the process of adding source 
files. Execute [Generate source files] after building or other setting has been completed. 
 
 
 
 
 
 

 

(6) Creating Programs Including the PDG-Output Functions 

You can control peripheral modules by simply calling PDG-output functions through a user program. For 
details on the functions and usage, refer to the reference manual for the MCU in use. 
 
 

Figure 3.21 Message on completion Figure 3.22 Message on CubeSuite+ busy 
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